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1.1 Scanning and Storing 

1.1.1 Storing in Folder Structures 

Component: DocuWare Client 

You can now work with folder structures in Web Client too, as before in the Windows 
Explorer Client. This kind of folder structure is based on the index fields of a file cabinet, 
which are arranged in a certain hierarchy. 

A folder structure includes, for example, the index entries for the Company field on the top 
level, the Project field on the second level, and the Document type field on the third level. In 
the folder structure display there is then one folder for each company at the top level, 
followed by folders for the company's various projects, and below these folders for the 
individual document types. The corresponding documents are then displayed in these 
folders. 

 
Folder structure in the Web Client 

These folder structures are also practical for storing: Within the folder structure, navigate to 
the location where you want to add documents. Then drag the desired documents to the 
folder structure from the document tray or from the desktop using drag & drop. The 
documents are then stored here. This means that they are automatically given index values 
that are predefined by the folder structure. You can add other index entries in the store dialog 
if needed. 

As an alternative to drag & drop, select the file to be stored at the desired location in the 
folder structure using the import function and a corresponding file selection window. 

If you use Google Chrome as a browser, you can also drag entire folders from the desktop or 
the file system to the DocuWare folder structure, in addition to single files. All documents in 
the folder are then stored in DocuWare, in each case with the folder name as an index entry. 
As a result, you then have the folder with the documents in your DocuWare folder structure, 
just like you did before in your file system. 

1 Storing Documents 
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 Application 

 You want to store a document for an existing process in which you were not previously 
involved. Therefore you are not exactly sure which indexing was previously used by your 
colleagues. Using the folder structure you easily find the right location for your document 
and drag it there. As the folder names make up the index entries, your document is 
immediately indexed and you have finished the task. And of course all documents for the 
process automatically have consistent indexing. 

 For one project you initially saved several files locally on your computer, in a folder in the 
file system. Now you want to store all these files. In the DocuWare folder structure, 
navigate to the location where the corresponding project folder is located and drag your 
local folder there too. For all files in the folder, both the name of the project folder and the 
name of the parent folder are automatically used as index entries. You only have to add 
index entries that are specific to single documents.  

 Benefits 

 Folders offer a structure similar to a filing structure for document storage 

 Intuitive access to the file cabinet for people who are used to hierarchical document 
structures, regardless of whether this is via conventional paper folders or the file system 

 Easily store documents for a process, even if you do not know exactly which index 
entries were used 

 Quickly store several documents with the same index entries 

 How to use the function 

Open the folder structures via the workspace folder: 

 

Access the function Import in the current folder via the drop-down menu: 

 

Define which of the folder structures assigned to you are to be displayed, and in which order, 
in the Settings on the Folder tab. 
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The folder structures are created at the file cabinet level in DocuWare Administration or in file 
cabinet administration within the DocuWare configuration (see Creating Folder Structures (on 
page 24)). The same folder structures are used as in the Windows Explorer Client. 
 

1.1.2 Dynamic Display of Index Entries 

Components: DocuWare Client, Intelligent Indexing 

If you use Intelligent Indexing together with the index card view in the document tray, the 
index entries suggested by Intelligent Indexing are dynamically displayed and color coded. 

 

 Benefits 

 Results of automatic indexing immediately displayed 

 Easy to select documents that can be automatically stored without opening the store 
dialog 

 How to use the function 

Display is automatic with Intelligent Indexing in connection with the index card view. 
 

1.1.3 Automatic Numbering 

Components: all clients and modules for storing documents 

Documents can automatically receive a unique number as an index value when they are 
stored in the file cabinet. Regardless of the user and the DocuWare client used, this number 
is assigned during the store process or when pre-indexing the document. The value is 
displayed both in the store dialog and in the index dialog, and can be copied for further use 
from there.  
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 Application 

 Unique number as a match code, e.g. between an invoice in DocuWare and the 
associated accounting record in the ERP system.  

 Orders received via email are stored with Connect to Outlook and are automatically given 
an order number which is then also used for further order processing in the systems 
concerned. 

 Invoices can be assigned to different departments via different number ranges. 

 Consecutive numbering for an incoming post book, which is a legal requirement in Spain 
or Italy for example. 

 Benefit 

 Easy linking of documents in DocuWare with other systems 

 How to use the function 

Automatic numbering is executed in text fields. Configure it in the file cabinet administration 
within the DocuWare configuration, via Store dialogs > Field > Predefined Entry > Automatic 
Numbering. Here you also have the option of defining the first number to be used. For 
subsequent automatically assigned numbers, this number always increases by one. 
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1.1.4 Configuring Text Recognition – Made Easier 

Component: DocuWare Configuration 

The settings for OCR (Optical Character Recognition) are made in the new area Text 
Recognition within the DocuWare configuration. By switching to HTML5, it is even easier for 
users to configure text recognition in all up-to-date browsers.  
Arabic text is also now recognized. 

 Benefits 

 For all browsers 

 Easier to configure 

 More languages 

 How to use the function 

 
Make settings for the recognition quality and languages. When selecting a language 
manually, depending on the language group selected, another select list appears on the 
right.  

You can continue to use all configurations that were created with the "OCR Settings" 
available up to DocuWare version 6.9. 
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2.1 Searching through Folder Structures 

Component: DocuWare Client 

As already mentioned under Store (on page 5), you now have the option to access file 
cabinets through folder structures in the Web Client . You can use these folder structures to 
search for documents hierarchically.  

If a folder structure includes, for example, the index entries for the Company field on the top 
level, the Project field on the second level, and the Document type field on the third level, first 
click on the folder for the company concerned. Folders are then displayed for each of the 
projects, and then under those folders for the available document types. As in the file system, 
you see all documents in the folders that match the selected criteria. 

 Application 

 You are searching for documents concerning a project for a customer and therefore 
select the customer folder followed by the project folder. First, you are interested in offers 
located in the folder for the document type. With just one click, you then switch to the 
orders by clicking on the appropriate folder. There is no need to run a new search using 
the search dialog. 

 You search for a document in a file cabinet that you rarely work with, and therefore are 
less familiar with the indexing. Using the folder structure, you have a logical way to  
quickly find the desired document. 

 For example, personnel or project folders can be displayed using the folders 

 Benefits 

 Folders provide similar access to documents as files 

 Intuitive access to the file cabinet for people who are used to hierarchical document 
structures, regardless of whether this is via conventional paper folders or the file system 

 Quickly access associated documents, because they are clearly located in a folder with 
the appropriate structure 

 Easily find documents, even if you do not know exactly which index entries were used 

 How to use the function 

See Storing in Folder Structures (on page 5) 
 

2 Finding and Displaying Documents 
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2.2 CSV Export of Result Lists 

Component: DocuWare Client 

When exporting result lists as CSV files there are now two options: export the entire result list 
or only the entries of the currently displayed page of the result list. 

 Application 

You want to analyze several documents of one type, e.g., incoming invoices, which are in 
your file cabinet. As a general search would lead to too many entries in the result list, it is 
easier to analyze the results in Excel. When exporting the entire list as a CSV file, you 
receive all entries in the result list, even if it contains over 10,000 entries. 

 Benefits 

 Easily handle result lists, even those with over 10,000 entries 

 Individual export options 

 How to use the function 

Result list > Export as a CSV File > Only current page in result list or Entire result list 
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3.1 Sending Inquiries 

Components: DocuWare Client, Workflow Manager 

This lets you send a short inquiry about a document directly from the DocuWare Client to 
your colleagues. Such inquiries are suited to one-off or rarely used processes for which 
setting up a standard workflow would be too time-consuming. 

 Application 

 The Head of Finance has negotiated a new lease with the lessor of the company building. 
To obtain the approval of the CEO, she assigns an inquiry to him. She specifies the 
subject and details of the email plus the decisions to be made. The CEO receives an 
email and approves the lease among his tasks or rejects it. The Head of Finance can 
immediately view the decision under "Assigned inquiries." 

 A team leader receives an interesting newsletter, that he wishes to forward by email to 
three team members. All three should confirm that they have read the newsletter. The 
team leader assigns this colleague an inquiry with the relevant information. All three 
employees receive the same email and each separately confirms that they have read the 
document. The team leader immediately sees who has already completed the inquiry. 

 Benefits 

 Simple and practical: Send inquiry directly from the DocuWare Client 

 Greater flexibility when using rarely needed processes 

3 Workflow: Controlling Business Processes 
Professionally 
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 How to use the function 

 
Send a request via the context menu of a result list or a saved list. The context menu entry is 
only displayed if a single document was previously selected.  

 
You can assign queries to one or more users or even roles. In doing so you can define 
whether the inquiries go to participants one after the other or simultaneously." 
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The inquiries you have sent can be viewed under "Sent Requests" (1). You can stop the 
inquiries at any time or close them after they end normally by clicking "Close task" (2). 
 

3.2 Changing Index Entries in the Current Workflow 

Component: DocuWare Client, Workflow Manager 

Under Tasks you can now edit the index entries for a document that is currently in a 
workflow. 

 Benefits 

 Greater flexibility when indexing 

 Faster working 

 How to use the function 

In the context menu through Edit index entries. 
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3.3 Overwriting Keyword Fields When Assigning Data 

Component: Workflow Designer 

When you assign data you can overwrite the entries in keyword fields. 

 How to use the function 

 
In the assignment concerned, enable the option "Replace" and enter the new text  
under "Entry." 
 

3.4 Opening Workflow Version in Read-Only Mode 

Component: Workflow Designer 

Each version of a workflow can be opened in read mode.  

 Application 

When creating a new workflow version, you can open previous workflow versions in read-
only mode to see how the process was structured in the past. 

 Benefit 

 Easier to track changes in the workflow 
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 How to use the function 

 
Open the old workflow versions in read-only mode using the Version History context menu. 
Only the current workflow version will be opened in edit mode. "Read only mode" will then be 
displayed on the tab in the workflow overview. 
 

3.5 Workflow Variables for Users, Roles, Substitution 
Rules 

Component: Workflow Manager 

There are two new options for variables: 

 Variable for user names, roles, or substitution rules:  
This enables you to assign a task to this variable easily at any time. In your invoice 
approval workflow you configure a variable for the role of the cost center manager, for 
example. You can directly assign the task of final approval of invoices to this role.  

 List variable for user lists, role lists, or substitution lists: 
This enables you to assign a task to multiple users, roles or substitution lists. 

 Benefit 

 Tasks can be dynamically assigned to several users 

 How to use the function 

 
If the variable is a list variable, enable this option. 
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4.1 More Options for Configuring Web Forms 

Component: DocuWare Forms 

The design of Web Forms and Merge Forms is simpler thanks to many small improvements:  

 Insert an image (for example your company logo) into the Web Form. You can adapt the 
size of the image element and align it to the left, center, or right.   

 Select a color for the Web Form background and specify the width of the form as it 
appears in the browser. You can also select the orientation:  

 

 You have unlimited selection options for radio buttons, checkboxes, and dropdown lists.  

 Use the entries from single-column select lists as selection options for a dropdown list. 
This reduces the time spent inputting information.  

 In the Merge Form Designer, the most important functions for the fill area tool are 
available directly by right-clicking:  

 

4 Teamwork 
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 Use a keyboard shortcut to enter frequently used commands like pasting or deleting. 
Ctrl+Z allows you to undo work steps.  

 Change several fill areas at once: Enable the desired fill areas, so that functions like 
orientation or resizing are applied to all areas.  

 Copy, Cut and Paste fill areas within a merge form. 

 Fill areas can be accurately positioned with the arrow keys.   

 Benefits 

 Less time-consuming for administrators 

 More options for designing Web Forms 

 Where you can configure the functions 

Web Forms and Merge Forms are configured in the Collaboration > DocuWare Forms area 
of the DocuWare Configuration. 
 

4.2 Free Design of Message after Form Is Submitted 

Component: DocuWare Forms 

Administrators can now edit the message that is shown to the user after the form is 
submitted. There are several options available for additional information to provide the user 
after submission: You can direct the user to a new form, a website, or the stored form. The 
actions can be performed manually, or automatically immediately or with a delay. 

 
For example, you can display the link to the saved form once the form has been submitted. 
This allows the user to call up their filled-out form from DocuWare at any time.  

 Benefits 

 Users can easily copy the link to the form 

 Several forms can be filled out more quickly 
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 How to configure the function 

The message is configured on the Submission tab of a Web Form configuration:  

 
 

4.3 Convenient Filling of Web Forms 

Component: DocuWare Forms 

The following new functions make it easier to fill out Web Forms: 

 When the user accesses DocuWare Forms from a smartphone or tablet, the display is 
automatically adapted to the mobile device.  

 Files can be attached to the Web Form from Windows Explorer using drag and drop.  
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5.1 Accessing Local Databases from the Cloud System 

Components: DocuWare Cloud, Autoindex 

Using the local data connector you connect your DocuWare cloud system to local databases 
to access dynamic data from there. For example, Autoindex can be used with your cloud 
system to access data that is on systems installed on site. And you can also access local 
data in the same way for external select lists. 

 Application 

 Accounting records an invoice in your on-premise accounting system with the sender, 
document number, date, and amount. If this invoice is archived in DocuWare, Autoindex 
can access the content of the local accounting data record from the cloud system and 
automatically add it as index information in DocuWare – without the user having to type 
the index entries first. 

 For consistent data and spelling, fill in a DocuWare select list dynamically with the 
company names from your customer database.  

 Read about other applications for autoindex here (http://pub.docuware.com/en/autoindex) 

 Benefits 

 Easily connect data from the on-premise systems with the DocuWare cloud system 

 Automatic indexing 

 Consistent data throughout different systems  

5 Integration into Company IT Systems 

http://pub.docuware.com/en/autoindex
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 How to use the function 

Install the local data connector through the DocuWare Desktop Apps. There it can be 
selected from the administrative apps area. 
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6.1 Managing DocuWare 

6.1.1 Conveniently Synchronize File Cabinets 

Component: DocuWare Configuration 

The new Synchronization module simplifies the synchronization of file cabinets, especially 
the data exchange of different DocuWare systems. In the newly developed interface you can 
select file cabinets from the cloud and local organizations with just a couple of clicks of the 
mouse. Even data reconciliation is possible within hybrid cloud systems: Documents can be 
mirrored or synchronized from the DocuWare cloud, for example, into an on-premise system.   

 Application 

 In order to regularly back up the central document pool of a company, the documents are 
synchronized every evening in a backup file cabinet. This ensures there is always an up-
to-date backup available.  

 Synchronize documents in a hybrid DocuWare Cloud system – for example when you 
use the DocuWare Cloud as a backup and transfer documents from your on-premise 
system to the DocuWare Cloud.   

 The database of several branches is compared with the database at the central office 
every week. The latest documents are transferred in each case. All branches therefore 
have the updated forms from the central office. Conversely, new customers who have 
been entered in the branches are added to the central document pool.  

 Benefits 

 Documents are quickly transferred 

 Flexible scheduling of the synchronization job 

 Synchronization jobs can be easily created and managed 

 How to use the function 

Access the Synchronization module in the System section of the DocuWare configuration.  

6 Other New Features and Improvements 
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The interface is subdivided into the sections Mirroring for the backup and Synchronization. 
Within these sections, all important functions are clearly listed for the application concerned:  

Mirror: 

 

 

Synchronization:  

 

Note: The Synchronization module does not display the synchronization jobs that are 
created with the synchronization workflow in DocuWare Administration. The jobs from the 
new synchronization module are also not listed in DocuWare Administration. 
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6.1.2 Creating Folder Structures 

Component: DocuWare Configuration 

Folder structures (on page 5) can now be created in DocuWare Configuration, in addition to 
in DocuWare Administration. There you conveniently drag the desired fields to a folder 
structure using drag & drop. You also select a store dialog and, if necessary, adapt the index 
information in the dialog. 

In order to make indexing even simpler, you can predefine empty folders. The user can then 
work with the predefined structures to store files. Entries from select lists are used to create 
empty folders.  

 
To use index fields as folders: Drag text fields into a folder structure in the file cabinet area of 
DocuWare configuration.  

 Benefit 

 Easy to set up with drag & drop 

 Where to find the function 

Create folder structures in the file cabinet area of DocuWare configuration under Dialogs > 
Folders.  
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6.1.3 Opening and Editing Fixed Select Lists from the Store Dialog 

Component: DocuWare Client 

Directly access the "Select lists" module from the store dialog to edit select lists saved in 
DocuWare from external sources.   

 
If a fixed select list is assigned to a field in a store dialog, you can directly call up the Select 
list module via the link and edit the select list there. 

 Application 

While working, the head of the department notices that a new cost center is still missing from 
the DocuWare select list. They open the select list directly from the store dialog in the 
DocuWare configuration and add the new cost center. The select list is immediately updated 
for all staff.  
This saves the head of the department from sending an email to the organization 
administrator asking them to customize the select list – less work all round. 

 Benefits 

 Faster access to the fixed select list 

 Easy to change the select list entries 

 Less administrative work 

 How to configure the function  

For the user to see the link to the select module, they need the new Maintain Fixed Select 
Lists functional right, which is assigned in DocuWare Administration under Organization > 
User Administration > User > Functions > DocuWare Administration. This right allows the 
user to edit existing select lists, but not to add or delete select lists.  
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Note: The previous Select lists right is renamed as Manage select lists. This right allows 
users to add, edit, and delete select lists. However, a link from the store dialog to DocuWare 
configuration is not displayed for them. 
Users who had the Select Lists right before the upgrade to Version 6.10 are automatically 
assigned both rights: Manage Select Lists and Maintain Fixed Select Lists. 
The rights Maintain Fixed Select Lists and Manage Select Lists can be assigned 
independently of each other.  
 

6.1.4 More Functions for the New File Cabinet Administration 

Component: DocuWare Configuration 

To make it easier to edit file cabinets in an organization, file cabinet administration is 
gradually being moved from DocuWare Administration to the DocuWare configuration. This 
DocuWare version adds the following functions to the DocuWare configuration: 

 Create folder structures (on page 24)  

 Set up user-defined file cabinet profiles and assign users and roles (see also Changes to 
file cabinet profiles and permissions (on page 26))  

 Overview of the four default profiles "Read," "Write," "Owner," and "Delete:"   

       

 

 Automatic Numbering (on page 7): Create number ranges for automatic numbering of 
documents and assign errors (only in DocuWare configuration, not in DocuWare 
Administration) 

 Select database connections when creating a new file cabinet  
 

6.1.5 Simpler Administrative Profiles and File Cabinet Permissions 

Component: DocuWare Administration 

To simplify the management of file cabinet profiles, there is now only one profile with 
administrative permissions: the default profile "Owner." The Administrator profile has been 
omitted. All users with an Administrator profile automatically receive the owner profile with 
the upgrade to DocuWare Version 6.10. 

The administrative right "file cabinet administrator" has also been renamed "operator." 
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 Where to find the function  

You can configure the file cabinet profile in DocuWare Administration under Organization > 
File Cabinets > Profiles > Administrative Profiles. You can find the file cabinet profiles in the 
DocuWare configuration in the File Cabinets > Advanced section.  

 
In the DocuWare configuration the permissions for a file cabinet profile can be clearly viewed 
at a glance. 
 

6.1.6 Modified System Requirements 

Connect to Outlook is compatible with the 64-bit versions of Microsoft Outlook 2010, 2013, 
and 2016. DocuWare version 6.10 does not support Microsoft Outlook 2007 anymore.  

MySQL 5.7 is also supported as a database.  
MSSQL 2005 cannot be used with DocuWare version 6.10. 

The complete system requirements can be found here http://help.docuware.com/en/#t55049. 
 

http://help.docuware.com/en/#t55049


 Other New Features and Improvements 
 

  

 
 

28 

6.2 Usability Improvements 

6.2.1 Better View with Multiple Tabs Opened 

Component: DocuWare Client 

If you have several document trays, search dialogs, lists, and/or tasks open at the same 
time, they will be displayed as usual in multiple tabs. As a new feature, you no longer have to 
scroll sideways to access each of the tabs. Instead they are all shown all of the time. If there 
is not enough space for the whole dialog name, the name is displayed when you click on the 
tab. 

To quickly close several tabs at once, there is now the option to close all tabs of the same 
type, for example all search dialogs, at once.  

 Benefits 

 All opened dialogs always in view 

 Quickly close several tabs at once 

 How to use the function 

 
To close all search dialogs at once. The same applies for document trays, lists, and folders. 
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6.2.2 Deleting Saved Searches 

Component: DocuWare Client 

Searches that were saved as lists can also be deleted directly in the Web Client: you no 
longer have to switch to Settings. 

 Benefit 

 Quickly delete single lists 

 How to use the function 

When you select lists, a trash can symbol is displayed next to the list name: 
 

 
 

6.2.3 Direct Access to Important Functions 

Component: DocuWare Client – Document trays, result lists 

The Options menu within the document tray has been discontinued. The functions concerned 
can now be selected as buttons directly in the document tray. 
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Frequently used functions are also available directly in the result list and no longer have to 
be called up from the Options menu. 

 

 Benefits 

 Fast access to the most important functions 

 No hidden functions 
 

6.2.4 Shortcut for Splitting Documents 

Component: Viewer 

To split documents in the viewer, as an alternative to the button  you can now 
also use the keyboard shortcut Ctrl+Alt+ comma (,). 

 Benefit 

 Work faster with keyboard shortcuts 
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6.2.5 New Setup for Desktop Apps 

Component: DocuWare Desktop Apps 

Setup for DocuWare Desktop Apps has been completely redone, from both the technological 
implementation aspect and the user navigation aspect. 

 Benefits 

 Simple standard installation without having to select modules 

 User-specific installation, particularly for administrators with additional modules 

 Faster execution of installation  

 Intuitive operation 

 How to use the function 

 
Start the installation as usual through the DocuWare Main Menu > Install Desktop Apps 
 

6.2.6 New Name: Monitor Tasks 

Component: DocuWare Client, Workflow Manager 

The "All Tasks" area is now called "Monitor Tasks." All tasks for workflows for which you 
have controller rights and that you have created with Workflow Designer will continue to be 
displayed here. 
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6.2.7 Assigning Data: Direct Selection of Suitable Variables and Field 
Types 

Component: Workflow Designer 

Only compatible field types will now be displayed when assigning data between workflow 
variables and the index fields of a file cabinet. For example, you will now only be able to 
assign a numeric variable to a numeric index field.  

If you still need to assign different field types to each other, use an arithmetic expression for 
conversion. 

 Benefits 

 Incorrect assignments are not possible with direct field assignments. 

 Conversion of field types is still possible. 

 How to use the function 

This function is automatically enabled for workflows created with DocuWare Version 6.10. If, 
for example, you wish to assign a field to a numeric variable, only numeric fields are 
displayed for selection. 

For workflows that were created with earlier DocuWare versions, incompatible field types can 
still be assigned to each other. 

If when assigning data you wish to convert its type, you can use the following VBA functions: 
CDate, CDec, CInt, CStr. 
 

6.2.8 Task Is Omitted for Deleted Documents 

Component: DocuWare Client, Workflow Manager 

If the document belonging to a task is deleted, the task itself will also be automatically 
deleted in the workflow. 
 

6.2.9 A Better Overview of Lists and Variables 

Component: Workflow Manager 

The select lists for form fields are sorted clearly: 

 In alphabetical order 

 Differentiated according to index fields and system fields 

Global variables are also listed alphabetically. 
 



 Other New Features and Improvements 
 

  

 
 

33 

6.2.10 Connect to Ricoh: User Interface in Multiple Languages 

Component: Connect to Ricoh 

The Connect to Ricoh client, i.e. the DocuWare user interface directly on the Ricoh device, is 
now available in a further 15 languages in addition to English: Arabic, Bulgarian, Chinese, 
Croatian, Dutch, French, German, Greek, Italian, Japanese, Polish, Portuguese, Russian, 
Spanish, and Swedish.  

 Benefits 

 Users enter information in their local language  

 Fewer errors when recording and indexing documents 
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